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The devastating effects of the budget cuts will extend to technology. Purchases
will slow. Support staff will be cut. Professional development funding will
disappear. Equipment that falls into disrepair will be ignored.

It�s easy to moan about the lack of funds, roll over, and do nothing. Don�t let it get
you. Even in the best of times it takes energy and determination to incorporate the
use of technology meaningfully into the curriculum. There�s still lots that can be
done. It takes more coordination, planning, and willpower during hard times.

At school sites much is in place. The web is widely available. A computer is on
every teacher�s desk. Labs are
common. Knowledge is
growing and skill levels are
rising. Basic software tools and
applications are widely avail-
able. References, lessons,
curriculum, and other resources
are available. There is often a
person on site who can help. The ESD instructional technology and technology
infrastructure support system is on call.

Start acting now. This spring take stock of the equipment you have, plan and do
maintenance, take a look at the skill set expected of staff and the skills they
currently have, and set goals for next year.

Create a plan for cleaning up and storing computers so that they are fully func-
tional for next year. In the ESD labs we reinstall operating systems, helper apps,
and software each year. This helps unclog the arteries and makes for fewer
problems in September. Put together a team of students to go through all the
computers in your school to do this work. Larry reminds us that students are
already there and they work for free. Call Larry (541.858.6748) and he can help
you create a cheap, simple system that works for your school.

Decide on the programs and versions of software you�re going to have on your
computer, establish a minimum set of skills that you want all the staff to master,
and spend some time working on that skill set, maybe during inservice week. Have
the teachers learn how technology can be incorporated in their lessons, and have
them begin gathering resources and creating lessons. Call a technology specialist
for assistance and direction, or visit our website at www.jacksonesd.k12.or.us/it
and explore our reviewed collection of curriculum and workshop links.

... students are
already there and
they work for free.
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A superficial use of computers is easy to achieve. Handing students a program or turning them loose in a lab to type a paper
is easy, but it doesn�t touch the true power of the technology to enhance learning. To move to higher levels of use and take
advantage of what technology has to offer requires planning and preparation. It�s hard to do it alone. Find ways to get with
others and share the load. Much more can be accomplished as part of a group. It�s also more fun.

Christopher Moersch developed the Technology Use Profile designed to explore the current role of technology use in the
classroom by measuring classroom teachers� level of technology implementation, personal computer use, and current
instructional practices. This questionnaire is at www.learning-quest.com/LoTi/index.html. To see where you fall in his
continuum go to www.learning-quest.com/LoTi/lotibreak.html for a description of levels of use.

The moral of the story is don�t let the financial blues get you down. There�s much to do�and lots of people who can help.

Attending high quality regional and national conferences is
always stimulating. This year�s Northwest Council for
Computers in Education (NCCE) conference was held in
Seattle and was especially satisfying, particularly in a proud-
parent kind of way.

There were hundreds of sessions, hands-on labs, workshops,
and over 20 featured keynote speakers for the 3000 attend-
ees. The technology specialists from Jackson ESD were
well represented among the presenters. Nick Viani offered a
session on writing strategies using his collaborative �Write

Site.� Larry Francis presented �Sound Practices,� the use of
text to speech. Tina Mondale served as a panel member on
Distance Education sponsored by Northwest Regional
Education Lab. Marty Karlin and Tina spoke on �The Art
and Science of Online Learning.� Marty, Larry, and Scott
Preston from Klamath County School District facilitated an
all-day session for Technology Responsible Persons. Morgan
Cottle fromAshland presented on the efforts his district has
made based on their TLCF grant. I felt proud that we have
so many talented technology-skilled specialists and teachers
in our region willing to share their work and ideas.

Since many Southern Oregon educators couldn�t be there, I
thought I would offer a virtual experience and describe the

high quality work your ESD instructional technology special-
ists are engaged in, and what opportunities are available to
you through the ESD�s Instructional Technology program.

As a backdrop I want to mention that standards are huge.
Schools should review them and begin to address site and
district goals. National standards for students, teachers, and
administrators now exist. These standards can be found at
cnets.iste.org/sfors.htm (for students)
cnets.iste.org/teachstand.html (for teachers)
cnets.iste.org/tssa/framework.html (for administrators)

Technology Responsible Persons
Here lies one of the essential keys to successfully integrating
technology. There exists a growing need for TRPs in schools
to help maintain existing technologies, provide onsite instruc-
tional technology leadership, and plan for the future. The ratio
of students to computers is now close to 4:1. District and
regional support personnel cannot keep up. Districts continue
to acquire systems faster than they hire personnel to support
them. There is a growing assortment of new and older, yet still
functional, technologies. There is a growing diversity in skill
levels of educators and administrators.

Field Notes and reflections from NCCE
By Marty Karlin

Blues (continued)

See NCCE on next page
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There is a growing gap between what one person can
possibly know and what there is to be known in the world of
technology. The people standing between schools and
infrastructure-collapse are the TRPs. Schools must dedicate
resources to the support of these individuals. Site-based
TRPs must connect with the larger universe of regional
TRPs to save themselves time and energy. �It takes a
village,� as Mr. Floppy is fond of saying. No one can do this
job alone.

To that end the ESD has established a listserv where TRPs
can post questions and offer solutions to hundreds of others
of their ilk. We have a new web page specifically designed
for TRPs. It�s at www.jacksonesd.k12.or.us/it/trp. A myriad
of TRP resources is posted there. We will be making a
special effort through the listserv to organize meetings at the
end of May in each county. A resource that you will be
hearing more about in the future is the Generation Yes
program. See how you can harness the energies and skills of
students to help in your school. GenYES is found at
www.genyes.org/genwwwy. Larry Francis is available to help
your site develop a system for computer maintenance.

Nick Viani has been working with technology assisted
writing for about 20 years. His latest project is the Southern
Oregon Write Site, an online, interactive environment for
sharing writing and digesting responses. The site is accom-
panied by lessons and resources that take advantage of
communication tools on the web. In his recent SOU course,
Nick referred to an online article, �Notes from Peter Elbow,
Writing Without Teachers,� that categorizes and cites major
elements from Elbow�s classic,Writing Without Teachers
(linked from the Southern Oregon Write Site). Elbow
believes that the way to learn to write is to write � a lot.
Nick�s current work provides the tools and structure to do
just that. Nick�s Write Site is now playing host to writers
throughout the state. (When it becomes world famous we
can say we knew him when.) Check out the Write Site and
related resources at www.jacksonesd.k12.or.us:591/it/cpost/
sows.

Larry Francis speaks five languages (8 if you include logo,
pascal, and HTML). For many years Larry has explored the
powerful links between speaking, singing, and language
learning. For Larry, writing is an old technology that you use
to make speech stand still. Digital audio is a newer technol-
ogy that makes speech stand still. Kids can see and explore
the connections between writing and speech without having
to worry about the output. Larry�s favest things at NCCE
besides the dozens of oysters @ the Brooklyn Oyster Bar
were Clicker4 and DeepFreeze. Clicker4 www.cricksoft.com
is powerful language arts software that includes word
processing, graphics, text-to-speech, and audio recording.
It�s expandable, so you can add graphics and record sounds.
I�m looking forward to showing it off here at the ESD.
DeepFreeze www.deepfreezeusa.com is security software for

Windows that allows users to make whatever changes they
want but reverts to the installed configuration when the
machine is restarted. Elegant in its simplicity and open in its
entirety: users aren�t locked out of anywhere. But whatever
changes they make disappear on restart.

Hall Davidson, the closing NCCE keynote illustrated the
strong connections between text and speech when he played
an interview in Spanish for the audience. Very few, including
those who had some Spanish could understand the interview.
When captioning was added (you turn on captioning in the
menu using your TV remote) even those who spoke little
Spanish were able to make much more sense of the spoken
word. Technology has provided Larry with a playground to
explore the wonders of text-to-speech. His web page at
www.jacksonesd.k12.or.us/it/staff/lf/sound practices de-
scribes his views and offers resources to educators.

John Chambers, the CEO of Cisco called eLearning the next
killer app on the web. Over 50,000 high school students and
a couple million college students are learning online. This
growing system of education is providing flexibility, a tool
set, a communications system, and a contemporary learning
medium unlike any before it. Tina and Marty have been
exploring this world and all its intricacies for the past
several years. They have developed Southern Oregon Online
School, an Internet-based high school as a consortium
among regional schools, and are involved in the develop-
ment of a statewide system to help make courses, profes-
sional development, resources, and coursework available to
high school teachers and students throughout Oregon.

Besides the aforementioned workshops, Tom Glover has
been putting together science workshops with a special focus
on science inquiry, and a website featuring local weather and
climate. Look for it at www.jacksonesd.k12.or.us/it/weather.

Joel Brain�s specialty is the use of video in the classroom.
He has created a travelling lab of computers and cameras
that he accompanies into classrooms for use by students over
a period of several weeks. Students learn to plan, storyboard,
shoot, and edit videos that support all curricular areas. See
the article describing our plans for the travel labs in this
issue of TechNotes.

Next year�s NCCE, Techscapes, will be held in Portland.
Find a way to attend. It�s worth the effort. In the meantime
take advantage of the websites referenced in this virtual visit
to NCCE and the expertise available locally.

NCCE (continued)

ThinkQuest Live 2002

�Exploring the Future of
Learning�

July 20-21, 2002 - Seattle, WA
www.thinkquestlive.org
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Instructional Technology
Summer Inservice
This summer, the Instructional Technologist department at Jackson ESD is pleased to offer two intensive summer profes-
sional development opportunities: Online Learning Institute, and LanguageArts and LanguageAcquisition Institute.

Online Learning Institute, June 24-28
The Online Learning Institute is a five-day, all-day event for teachers serious about getting into the world of Internet-based
learning. This weeklong June workshop will put an online course in the hands of teachers, train them to teach on the web,
and assist in making the course available online to your students. This workshop is open to teachers throughout the state who
want to teach for an online school or are just interested in adding an online component to a face-to-face class. A separate
pullout in TechNotes provides detailed information.

Language Arts and Language Acquisition Institute (LALA), August 19-23
Language Arts and Language Acquisition (LALA) is a collaboration among the Migrant Education, Special Education,
Curriculum, and Instructional Technology programs of Jackson ESD to provide a week of intensive, one and two-day
workshops revolving around various aspects of language acquisition for all students. LALA is part of a larger inservice week,
�The August Institute,� involving several Southern Oregon school districts. In addition to the offerings described below,
learn more about The August Institute at www.jacksonesd.k12.or.us/it/lala.

Migrant Education
Migrant Ed will present a two-day workshop for elementary and another for secondary teachers on strategies for
mainstreaming English Language Learners (ELL) into regular classrooms.

What Works with Second Language Learners and Why?
Prepare yourself for that first newcomer who comes into your classroom not knowing one word of English. Begin by
becoming aware of the personal resources you already have, and learning how to project that welcoming attitude to the new
English Language Learner (ELL) in your class. In this training, methods and techniques are presented that are especially
useful with ELLs. This session gives you the tools to meet the needs of your ELLs within the framework of the regular
classroom. An added bonus gained from this session: these methods and techniques will work with all of the students in your
classroom! Separate two-day sessions for primary/elementary and intermediate/secondary will be presented.

Jackson ESD Curriculum
Jackson ESD Curriculum is contributing the following workshops to LALA week.

Early Reading and Federal Legislation
New federal legislation provides focus, incentives and potential sanctions for school success with early readers. This one-
day overview will provide sessions on the �No Child Left Behind� legislation, recognized �Researched-Based� Programs,
school implementation, grant opportunities and reading programs.

Differentiation by Design
Meeting the needs of TAG (talented and gifted) students in a regular classroom setting can be challenging. Come network
with other teachers and share ideas. Participants will learn what the law requires, the role of the classroom teacher, how to
write, manage, and conclude a PEP, strategies for delivering TAG services, how to make connections to the benchmarks, and
what resources are available.

Storytelling, StoryFest and Speaking Benchmarks
Barbara Griffin, Children�s Literacy Specialist and Storyteller extraordinaire, will share stories and teaching strategies to
help students understand traditional story research, story analysis, and how to prepare preparation for story presentation.
Barbara will provide handouts for guidance in preparing students to succeed as storytellers during classroom activities.
Included is information about StoryFest, a student activity in which students come together to present traditional stories.
Participants will practice scoring of student storytelling by viewing videotapes of previous StoryFests.
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Super Seven Reading Workshop
Looking for creative strategies to help students meet the state reading standards? Join fellow educators in this interactive
and practical training for grades 2-10. Review the seven reporting categories of the Oregon Reading/Literature test, includ-
ing close examination of the eligible content and sample test questions. Learn instructional strategies and participate in
classroom activities to strengthen student skills in reading areas.

Center for Educational Technology
Kelly Bryant, ESD Media Specialist, will offer a full day session to help mediabrarians put the Internet to work in their
schools.

Tools, Techniques, and Tips for Library Media Specialists
Get yourself organized to help your school with their web needs. During this all-day session you�ll get practical tips on how
to organize and publish web resources for staff and students efficiently using your own web page to house your search sites.
You�ll also learn how best to teach electronic search strategies to students both for online and print resources. This will be a
wonderful opportunity to meet with other librarians to discuss media life in the digital age.

Instructional Technology
Instructional Technology will feature two days of technology-assisted writing using the Write Site and other digital writing
resources; a two-day workshop on using audio to support language acquisition and language arts; and one day on using
software and learning strategies to enhance reading instruction.

Technology-assisted Writing
Teachers and students write to communicate effectively. Tenets of the writing process follow a path that shapes student
drafts, revisions, response sessions, and teacher feedback into final copies. Driving the process is the writing curriculum,
where carefully crafted lessons focus on strategies authors employ to improve their writing. The role of technology in this
process is a not-so-subtle supportive role. Teachers involved in ESD writing projects using the Write Site and other technolo-
gies observe improved student writing, increased enthusiasm about their writing, and greater student involvement in respond-
ing to classmates� writing. Participants in this two-day workshop will write, respond online, join in a literature discussion
circle, demo eJournals as part of an I-Search research project, explore online resources to support writing instruction, and
develop and share writing lessons as members of our local cohort of Language Arts teachers.

Audio Tools for Reading and Writing (a.k.a. Sound Practices)
Reading makes text talk. Writing makes speech stand still. So, audio has powerful uses in helping students with language
learning and literacy. With computers and free/cheap software and hardware teachers can now take advantage of this
learning modality. Workshop participants will go deep into text-to-speech and sound recording freeware for both Mac &
Wintel platforms. At the end of this 2-day workshop, participants will leave with Oregon State Standards-based strategies for
using digital speech and audio, lessons they�ve created themselves to go with the strategies they�ve learned, practical skills
necessary for making the (free) software and cheap ($6) hardware work, and access to scads of resources on the web.
Participants will create text documents, PowerPoint presentations and slide shows, and a web page�all with sound files
inserted. Learn more at www.jacksonesd.k12.or.us/it/staff/lf/soundpractices.

Technology in Primary/Elementary Language Arts (presented by Christine Beck and Kary Rogney)
This workshop will highlight successful projects, software, and strategies to integrate technology into the primary Language
Arts curriculum. Hands-on activities, demonstrations, and Internet resources will be shared and discussed. Participants may
be asked to switch roles from teacher to primary child in this presentation by the Central Point Tower of Primary Power..

Special Education Program

Not Being Able to Speak is Not the Same as Having Nothing to Say
For student with disabilities�even those with severe disabilities and those with little or no functional language�communi-
cation is a very important skill. Other ways for those students to �speak� are to use sign language, communication or
adaptive devices, and picture symbols. Sessions about these communication systems will be offered, covering low tech as
well as high tech tools. Another session will offer practical answers to these questions about assessing language skills for
those with disabilities: What tests can be used (formal and informal)? How can functional communication needs be deter-
mined in real life settings? How can the communicative intent of behavior be examined? If you work with children who
have language difficulties associated with a disability (whether in a special education or regular education classroom), these
workshops will give you some excellent ideas!



6

You�ve got your district�s web server. If your situation is like
mine, all the computers in your school are protected behind
your district�s firewall/proxy. This is good, as it protects
your computers inside the schools from Internet-based
attacks. But you might want an intranet web server inside
your district�s firewall for internal school access.

For example, you might do this if you want to set up some
web-based discussions and forums for your staff that won�t
be available to the �outside� Internet world. Or you might
want to do this if you want your students to write some web-
server-side CGI or PHP scripts. Or you might want to write
server scripts that store and fetch information from a
backend database for delivery of dynamic html content. Or
you might want to serve up a web-based calendar/schedul-
ing/appointment application for your staff.

I set up a web-server/file/print server in my classroom that
can be accessed by everyone in Grants Pass School District
schools, but cannot be accessed from the outside �Internet
world.� Perfect for my Advanced Web Page Design students
to learn some server scripting, and a good place to deliver
intranet content to staff. This three-part article series
describes how you can do this, on the cheap.

As a plus, you might want to throw away that old MS-
Windows NT/2000 server you were using (not the hardware,
just the Windows NT part), or that Novell server (again, just
the Novell software, not the hardware), because the setup I
will describe can offer the file and print services for both
Windows PCs and Macintoshes that Windows NT/2000/XP
(or Novell) offers, and it can be done at considerably lower
cost.

How are we going to do this on the cheap? How can you set
up a web server, and even replace a Windows NT Server or
Novell Server, at a cost of nearly zero dollars and zero
cents? Does it all sound �too good to be true?�

Well, it�s not: we�ll do it by using Linux as the Operating
System. This is the first article of what will be a three-part
series on how to accomplish this.

Linux is (Mostly) Free
What many people do not understand is that the Linux OS
(more correctly called GNU/Linux), and most of the
applications that you can get with it, are free. Linux is �Open
Source� software. Various companies do sell Linux. They try
to make money by selling manuals, support, and value-added

software. These companies bundle the GNU/Linux programs
together into an easy-to-install package called a �distribu-
tion.� But, because of GNU/Linux copyrights, each com-
pany selling a distribution of Linux must make their basic
distribution available for download�for free.

What Software Comes With Linux?
What software is typically bundled with Linux? One key
program is the �Apache� Web Server, a far better and more
secure web server than Microsoft�s IIS (Internet Information
Server). Another application that comes with Linux is
�Samba�, which is a program that allows a Linux server to
emulate a Windows NT/2000 server, or deliver Windows
peer-to-peer shares. Finally, �netatalk� is a program that
allows a Linux Server to provide Apple Macintosh file and
printer sharing services. A complete Linux distribution also
comes with thousands of other programs, including a nice
(�windows-like�) GUI called KDE that allows you to use
Linux as a workstation.

Part 1 of a 3-part series on using Linux to set up an Intranet Web server and
Windows and Mac file and print services

Open $ource: free servers
By Gary Frankenberry, Grants Pass High School

This view is from a MS-Windows screen (using Network
Neighborhood) showing a list of the directories and
printers being shared from my Linux computer (whose
name is Penguin). Linux runs a program called
�Samba,� which lets it emulate a Windows 2000/NT/XP
server, or a Windows peer-to-peer share. Linux will also
provide these file and print services for a Macintosh,
using a program called �Netatalk.�
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How Do I Get Linux?
To do it for $0.00 cost, you need two-things: a high-speed
Internet connection, and a CD-Recordable drive. You will
download a Linux distribution, and then burn Linux onto
(three) CDs. The closest Linux Mandrake site is at Oregon
Statue University. Go to ftp://ftp.orst.edu/pub/mandrake/iso.
There you will see three huge .iso (CD-image) files, each
about 648MB in size:
1. Mandrake82-cd1-inst.i586.iso
2. Mandrake82-cd2-ext.i586.iso
3. Mandrake82-cd1-supp.i586.iso

After downloading these three files, use your CD-burner
software to burn your three Linux CDs. You can then begin
the install process by booting the server computer from the
cd1 install disk.

I Don�t have a CD Burner, high-speed Internet Connec-
tion, the Time, or the Expertise�How Can I Get Linux?
Go to www.cheapbytes.com. Click �Enter the Store.� Scroll
down to the line that says: �Want to Order Mandrake Linux
8.2?� Click on �3CD-ROM Set, shipping, $5.99.� Click on
�order.� Click on �Check Out US.� Fill in the order form
(you�ll need your credit card). Total cost is $10.99 ($5.99
plus $5.00 S/H).

I Know I�m Going to be Lost, I Want the Manual�
How Do I Get It?
Order Mandrake Linux 8.2 direct from Mandrake. Go to
www.mandrakestore.com. You want the �Mandrake 8.2
Powerpack� at $69 + $15 shipping for a total of $84.00.
(This is a 7-CD set with manuals.)

Or, download the manual in Adobe PDF format or html
format from www.linux-mandrake.com/en/fdoc.php3. This is
the manual to the older version 8.1 of Mandrake Linux�the
newer manual to the 8.2 version is not online yet, as far as I
know. However, Mandrake does provide a (wonderful)
tutorial on the 8.2 install process (with lots of pictures). Find
it at www.linux-mandrake.com/en/demos/Demo/Man-
drake8.2/Install.

Finally, you could follow the more expensive route. Go to
Staples or Fry�s Electronics, and purchase a copy off the
shelf. You do not need the ProSuite Edition. Price will vary
from $70.00 to $150.00. Given that there are no client
licenses to buy (like there are with Windows XP, 2000, or
NT), even this most expensive route is relatively cheap when
you consider the TCO (Total Cost of Ownership).

Wait a Minute! What Kind of Computer Hardware Do I
Need for Linux?
Mandrake Linux (functioning as a Server) requires a
computer with a Pentium, Athlon, Duron, or Thunderbird
processor, preferably 300MHz or faster, with 128MB or
more RAM. A 20GB hard disk drive would be adequate. A
computer that can boot from its CD-ROM drive is needed.

Please note that Linux Mandrake, unlike other distributions,
requires a Pentium, Athlon, or Duron processor�it will not
install on older Intel 486 processor-based computers.

Since this computer will be a web server as well as offering
file and print services for Windows and file and print
services for Macintosh, more RAM (256MB to 1GB) and a
bigger had disk drive (40GB to 100 GB) would be better.
(Note: a good combo would be twin 40GB HDs, one
primary, and one for mirroring or backup, with 512MB
RAM).

Can�t I Install Linux Mandrake on Macintosh?
Yes, Mandrake Linux is available in a version for the
Macintosh; but since I don�t have any experience with that,
I�ll limit this discussion to the PC-route.

What Else Do I Need?
Your Linux server should have a fixed IP address. My
District Information Services staff suggested to me a fixed
intranet IP address (a type of IP address designated for
internal use inside a firewall that starts with 10-dot) that I
could use for my Linux server (it�s 10.5.5.128). You should
also know the IP address of your District�s Domain Name
Server computer (DNS server). Finally, if you have a router
(gateway) IP address for your Internet connection, you
should have that.

If you plan to provide printer shares to printer(s) connected
to your LAN, you should know their IP address(es).

This screen clip shows the language configuration part of
the Linux Mandrake install process. The installation is
graphical with clear instructions at each step.

See Linux on next page
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Although a typical Linux installation is getting better at
hardware detection, it is probably a good idea to know what
brand/model of NIC (Network Interface Card), and what
brand/type of video card your computer is using.

WhatAbout Other Linux Distributions?
I�ve heard that Red Hat Linux, Suse Linux, Debian Linux,
Elx Linux, Redmond Linux, Caldera Linux, Corel Linux,
and Slackware Linux are good distributions of Linux.

I�ve head that �Red Hat Linux� is best. Why do you use
Mandrake Linux?
There are currently six major distributions of Linux:
Mandrake, Red Hat, Suse, Slackware, Debian, and Caldera.
There are about 50 other minor distributions, most of them
specialized. There are distributions for the Macintosh, as
well as computers based on other processors. Some distribu-
tions specialize as servers, some as workstations, some as
both.

While Red Hat Linux is the most popular, I like the Man-
drake distribution, because it is one of the easiest for the
neophyte to install, and can be configured as a server,
workstation, or both. It comes with a program called
�Webmin� which allows you to administer it from another
computer�s web browser. The popular Red Hat distribution
is great for a server, not so good for a workstation.

Isn�t Linux Hard to Install and Configure?
Yes and no. Relatively speaking, no. Remember that most
PCs and all Macs come with the operating system
preinstalled and preconfigured. If everyone who owned a
computer had to get a distribution of Windows (Windows
95, Windows 98, Windows 98SE, Windows ME, Windows
NT, Windows 2000, or Windows XP) and install and
configure it from scratch, Windows would quickly gain a
reputation for being difficult to install and configure.

In addition, more people are familiar with Windows, so
there�s moreWindows expertise and assistance nearby, when
you need it.

So, yes, Linux can be daunting and tricky to install and
configure�it is not Windows, it is not the MacOS. It is both

multi-user and multitasking. It can be configured as a server,
a workstation, or both. But, within the last year, Linux
distributions have become much easier to install and
configure. If you struggled with installing Linux two or more
years ago, please understand that the whole process has been
greatly simplified and improved.

In fact, the latest distributions of Linux typically autodetect
and autoconfigure most sound cards, video cards, CD-RW
and CD-ROM drives, DVD drives, zip drives, scanners,
USB ports, and even firewire cards. Software is available to
connect and use your Palm Portable or your digital camera.1
What�s In The Next TwoArticles?
Part 2 of this series will focus on
� details on the Linux install process,
� setting-up a web server,
� setting upWindows and Macintosh file shares on your
Linux Server, and

� setting-upWindows and Macintosh printer shares on
your Linux Server.

Then, in Part 3, the last article of this series, I will discuss
� setting up specific intranet web services (forum discus-
sions, calendaring/scheduling, classroom assignment
posting, etc.),

� using a backend SQL database (Mysql and Postgresql),
and

� PHP and Perl server-side programming and scripting.

References/Resources:
To see a list of links of resources regarding Linux and open
source software that is available to educators, visit
www.jacksonesd.k12.or.us/it/information/tn/
linuxresource.htm.

1 Off topic, but the other night, at home, I found a great
Jazz Internet Radio Station, which I access from Linux
using a program called Xmms (with MS-Windows, you
would probably use Microsoft�s Media Player). With my
new high-speed cable modem Internet access, I get very
good sound quality.

Linux (continued)

�The Summertime is Comin�,� as the Scottish folksong proclaims,
and for those of us with at least one foot in the tech whirl, it�s not
all wild mountain thyme and purple heather, bowers, and such.
There are things we should be doing to get ready.

Back up everything important to your school or district server
Everything on this earth will someday fail. The someday for your
hard drive may be this summer. If your work is backed up, it will
be easy not to care quite so much.

Throw away the ink jet cartridges now in your HP printers. They�ll
dry out over the summer and be unusable anyway in a couple of
months. Or check out the computers and printers to your staff and
have them use them during the summer and keep the toner toned
while they become more proficient. Or remove the cartridges from
the printers, put them in sealable baggies, suck out the air with a
straw before sealing, and put them in the �fridge right side up.
(Don�t try this with Epson printer cartridges: once you remove
them, they are ruined.)
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As the Jackson ESD Materials Specialist (library media
specialist), I am always advocating using materials to help
students, staff, and other media specialists solve problems.
That includes television. Might sound like blasphemy
coming from a lifelong book lover, and promoter of reading,
but it really is part of my job. TV Turnoff Week, which was
observed April 24-30, really helps us teach students how to
use television to get information and, yes, be entertained.
Although Television Turnoff week has come and gone, here
are some thoughts and ideas on how you can promote it all
year around.

As a classroom teacher, I constantly was
telling my students that reading has two
purposes�information and entertainment.
That rule goes for all of our sources in the
library. Websites, electronic databases,
videos, DVDs, and yes, again, television.

We need to teach our students how
television can be a tool, rather than a
mindless time-sucker. One way is to model
in our own classrooms. Choose a program
that the class is going to watch. Put it on
and show how students can mentally
interact with what�s going on during the
program. It might be as simple as giving
them some key concepts to watch for, or
having them come up with one idea or
segment they thought was interesting.

Give students a way to chart their TV watching PRIOR to the
turn off week (and any week can be turnoff week). Have
them keep track of their program-watching. Chart when,
how long, and why they watched the shows they watched.
The WHY category is important. We want students to make
wise decisions using other resources, and television can be
added to that list. Have the students list briefly why they
want to watch that particular show. This idea will be new to
them. Model this during your classroom television viewing.

After the week of �practice television watching� has
occurred, then have your kids bring in their charts and
discuss commonalities and differences between their
viewing. This can be done with small groups; then get the
whole group together to summarize.

For the actual TV Turnoff the week, have the kids look back
at their practice charts. Have them set a goal of how much
television they will watch. Have them look through their

Making students better viewers

TV Turnoff Week
By Kelly Bryant

viewing selections and pick what they really want to watch.
Have them try to balance it with informative and entertain-
ment programming. Also, have them cut down their total
watching by 50%.

Resources

Make one of their goals to watch a program that has a
companion website. These websites have further informa-
tion and activities and can generate a lot of interest. Using
these companion websites helps students �preview� or

�postview� their programs. I would suggest the following as
good jumping-off places for quality websites dealing with
children�s programming:

Website of The Discovery Channel dsc.discovery.com

Website for teachers at Public Broadcasting
www.pbs.org/teachersource

Cable in the Classroom www.ciconline.com

50% is not a �total turnoff� (pardon the pun), but it lets kids
make some decisions based on hard data. Isn�t that what we
want them to do: to be questioning, evaluative learners? I
think by giving your kids some framework for turning off�
and on� the television, their viewing of TV will be more
mindful and productive. You may contact me for more
information at kelly_bryant@jacksonesd.k12.or.us and by
phone at 541.772.2751 or 800.636.7453.

Graphic source: www.adbusters.org/campaigns/tvturnoff
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In our last issue we talked about using video in the class-
room. We recognized it as a powerful communication
medium and that it has its own special language. I suggested
that learning that language is best done within the process of
creating a video. And we recognized an obvious parallel
between the writing process and the video process.

In this installment we look at some ideas for capturing and
editing video with students. I�m making the assumption that
you have a computer that is able to capture and edit video.
Not sure?

Edit Decision List

You�ve done the planning, and your students have been
shooting video. Now it�s time to bring it into the computer.
Before you connect any cables, it�s a good idea to decide
which chunks of video you want to capture. To do this,
connect your camera to a TV and have your students watch
all the video they�ve shot. While watching they decide which
takes are keepers. Label these and write down the start and
stop (In and Out) numbers for each. (Refer to the time code
or counter numbers on the camera.) You�ll end up with an
Edit Decision List (EDL.) Since everyone has an opinion,
everyone on the project team should be involved in this
process. And since some people have very strong opinions,
having a teacher-type around to moderate the discussion is
probably a good idea.

The Language of Video�part 2:
capturing and editing
By Joel Brain

If students don�t have a lot of garbage footage, and if the
computer has plenty of hard drive space (215 MB per
minute of video), you can forget the EDL and just capture
everything you�ve got. This is quicker and it allows the
students to postpone the decisions until they�re editing the
video on the computer. It�s easier to compare takes on the
computer since students won�t need to continually rewind
tape on the camera. This works well with small projects and
especially if they did a good job during the planning phase.
Hook up an external monitor so the team doesn�t miss out on
some important discussion.

Capturing Video

You won�t need the whole group for this. I recommend
selecting a couple of students to work together. The captur-
ing is actually fairly easy. The tape is in a camera set in VTR
mode. Connect the cable(s) from the camera to the computer
and launch the video editing software. Most software allows
you to operate the camera through the computer. Often this
interface looks much like the controls on your VCR.
Working from the EDL, students grab the video they need.
They should capture a couple of seconds of tape before and
after the desired clip so they�ll have enough room to
accommodate any transitions they�ll want to use. That�s it
for capture!

Editing

First off let�s explore a potential problem and look for
solutions: five or six students have lots invested in this
project, yet editing happens on a single computer. Kinda
hard to keep everyone on task, right?

Help teams select two students to do the editing. Try to get
one with good computer skills and one that has a good
overview of the project. These editors will need to talk with
the group about what they are going to do, go and do it, then
come back to the group and show what they�ve done, getting
feedback and more direction.

When I�ve done this in the past, I�ve found that when the
two editors come back to the group they never leave again.
Others in the group start making suggestions and the editors
just make the changes with the group watching. Feedback is
immediate, they all had a part in the editing decisions, and
they are all focused on the project.

Another strategy I�ve used is to copy the captured video to
more than one computer. This allows more kids to edit in
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smaller groups and it�s easier for quieter kids to get their
ideas used. It�s always interesting to see the variations that
occur as different students edit differently.

The editing process is somewhat involved but it includes the
following:
� students move the captured clips to a timeline and
arrange them in the desired sequence. Still images can be
brought in at this stage.

� students crop each clip as needed.

Transitions

After this it�s time to apply transitions. A word here: 90% of
the transitions used in movies and television are direct cuts.
There�s a reason for this: fancy spins and peels may look
cool but usually detract from the message. You�ll want to
mention this, but you probably won�t be able to convince
your students. When they watch later they may come to
understand the wisdom in transition moderation. (Come to
think of it, it could be many years before they recognize the
wisdom in any kind of moderation.) Fades and dissolves are
used to show a change in time or place. The question to
ponder: does your transition help get the message across?

Titles and Credits

Students usually want to add titles and credits. They should
use a font that�s easy to read and make it large. This is
especially important if they are intending to publish this to
the web. Students will have the option to make these titles
appear over the video as it runs or to place the title over a
solid color background. Either will work�just make sure the
text color contrasts well with the background.

The Soundtrack

Audio is very powerful. Don�t believe it? Turn off the sound

on the next movie you pop into your VCR. We tend to think
of video as a visual medium, but an audience that will put up
with some visual errors often has little tolerance for poor
quality sound. Yes, audio can be edited but it�s not always
easy. That�s why it�s best to get it right during shooting. A
variety of techniques can be used to separate audio tracks
from the video. And shareware like SndSampler ($30)
(www.provide.net/~moorepower/ahg/sndsampler) allows
you to edit audio tracks. It�s a great tool to use when the
recorded audio is too quiet.

Students can add audio later, too. Recording directly to the
computer is an easy way to create voiceovers. And don�t
forget background music�it�s a powerful emotional compo-
nent. Stick an instrumental (lyrics take away from the
content�remember, it�s all about communication) compact
disc in the CD drive and snag some. For copyright consider-
ations, check out (www.peachboys.com/hme/copyright/
copyright.htm) Better yet, don�t even worry about copyright
by having students create some original music as the
background music.

You may be wondering why I haven�t given step-by-step
instructions for editing video. That�s because each editing
program is a little bit different. Besides, most programs have
their own tutorials and there are a variety of web resources
available.

What�s it Gonna Take?

Whether you�re trying to capture analog or digital, you�ll
need a computer with plenty of processor speed, lots of
memory, and a lot of HD space. Depending on the editing
software you buy, you�ll need a system that looks something
like this:

A computer that runs at 300MHz or better WITH 128MB of
RAM and as much hard drive space as you can get (a 5-
minute movie uses over a gig of HD space so you decide

how much you need). In addition, your computer must have
some kind of capture card. This card gives you the ability to
bring video into your computer. An analog camera requires
an �analog� capture card (the computer will have S-Video or
RCA inputs) A digital video camera requires a �digital�
video capture card. (The computer will have a USB or
firewire port.) One of these cards came installed with your
computer if you purchased a Mac in the last year or so. If it�s
a PC, you may need to buy a card (you can buy one for less

See Video on next page

�Come to think of it, it could be many
years before they recognize the

wisdom in any kind of moderation.�
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Video (continued)

than $100 and they usually come bundled with editing
software�that brings us to the next item.

Software

Which product? That depends on your system (above),
especially on whether you�re capturing analog or digital
video. To go digital on a PC, check out Pinnacle�s Studio
DV Version 7 (www.pinnaclesys.com�a very nice program
for around 100 clams).

To go digital on Mac, iMovie2 is a great little product and
will set you back $49, (www.apple.com/imovie) and the
good news is you probably have it installed on your com-
puter if you purchased your Mac in the last year or so.

Cameras (camcorders) are another consideration. If you�re
looking for a digital video camera, you�ll need to decide
between mini-DV and Sony�s D8 format. Mini-DV seems to
be the standard but D8 tapes are cheaper and most of the
cameras in this format allow you to play tapes from older

8mm or Hi-8 cameras. This may be a good idea for schools
as there are a lot of those older cameras out there on closet
shelves in media centers and parents� homes. Models change
all the time, but Sony, Canon, JVC, and Panasonic have
good reputations. Prices start at around $500. Check out
www.cnet.com for reviews and prices then go to your local
camera store. They�re usually competitive; they�ll be there if
you have trouble and you�ll get some human contact.

Resources

For Studio DV check out: howto.lycos.com/lycos/series/
1,,5+24+26055+24783,00.html

For iMovie2 look at: desktopvideo.about.com/cs/imovie

A nice little tutorial that walks through the entire process of
creating a video can be found at: www.sotherden.com/
video101

A nice graphic overview of the process is found here:
www.apple.com/education/dv/tips

Curious how you and your students will save this movie�to
your DV camera, VHS tape, CD-ROM, DVD, the web? We
still need to explore the range of possibilities for publishing
video and I�ll address those issues in The Language of Video
(Part 3) in the fall issue of TechNotes.

What�s so different?

21st Century Skills
By Cheryl Lemke (© NCREL, used with permission)

In this digital age, intellectual capital drives progress, so
political, social, and economic advances in the 21st century
will be possible only if the intellectual potential of
America�s youth is well developed. To accomplish this, we
must meet the changing learning needs of all students.
The enGauge 21st Century Skills were developed through a
process that included literature reviews, research on emerg-
ing characteristics of the Net-Generation, a review of current
reports on workforce trends from business and industry,
analysis of nationally recognized skill sets, input from
educators, data from educator surveys, and reactions from
constituent groups.

An extensive review of the literature on 21st century skills
suggests that educational decision makers must acknowledge
that the academics of yesterday are not sufficient for today.
To adequately prepare, students must learn content within
the context of 21st century skills.

This list identifies the skills 21st century students need to
thrive. It is intended to serve as a bridge across public,
business, and education sectors through common definitions
and contexts.

Digital Age Literacy-Today�s Basics
� Basic, Scientific, and Technological Literacies
As society changes, the skills that citizens need to
negotiate the complexities of life also change. In the
early 1900s, a person who had acquired simple reading,
writing, and calculating skills was considered literate. In
recent years, we�ve come to expect that all students will
be able to read critically, write persuasively, think and
reason logically, and solve complex problems.

� Visual and Information Literacy
The graphic user interface of the World Wide Web,
advances such as digital cameras, graphics packages, and
streaming video, and the convergence of voice, video,
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� Personal and Social Responsibility
Emerging technologies often present ethical dilemmas.
As complexity increases, society needs new values to
guide the application of science and technology and to
manage the use of powerful new tools at the personal,
community, and governmental levels. It is important for
students to grasp this responsibility and contribute as
informed citizens.

� Interactive Communication
In this digital age, it is imperative that students under-
stand how to communicate using technology. This
includes asynchronous and synchronous communication,
such as person-to-person email interactions, listservs,
group interactions in virtual learning spaces, chat rooms,
MOOs, MUDs, interactive videoconferencing, phone/
audio interactions, and interactions through simulations

and models. These technologies add new dimensions to
communication that must be mastered, including
etiquette unique to particular environments, scheduling
over time zones, and cultural/language issues.

Quality, State-of-the-Art Results
� Prioritizing, Planning, and Managing for Results
High levels of complexity require careful planning,
managing, and anticipating contingencies. This means
more than simply concentrating on reaching the main
goals of a project or keeping an eye on project out-
comes; it requires the flexibility, creativity, and the
ability to anticipate unexpected outcomes as well.

� Effective Use of Real-World Tools
Doug Henton describes three types of knowledge
important to today�s economy: Know-what, Know-how,
and Know-who. Choosing appropriate tools for a task
and applying them to real-world situations in ways that
add significant value results in increased collaboration,
promotion of creativity, and the development of useful,
high quality products.

High Quality Results with Real-World Application
Researchers are finding learning benefits for students who
build authentic products with tools-whether they be sand
castles, computer programs, documents, graphs, LEGO
constructions, or musical compositions. Such experiences
provide students with deep insights into whatever domain of
knowledge and whatever tools they use.

and data into a common digital format have increased
the use of visual imagery dramatically. Students need
good visualization skills to be able to decipher, interpret,
detect patterns, and communicate using this imagery. In
addition, they need to be able to access information
efficiently, evaluate it critically, and use it accurately.

� Cultural Literacy and Global Awareness
The world is rapidly becoming wired, and the resulting
globalization of commerce has increased the need for
cultural literacy. In such a global economy, the ability to
know, understand, and appreciate other cultural forma-
tions�including those established by technological
society, i.e. virtual realities�is key to a competitive edge.

Inventive Thinking-Intellectual Capital
� Adaptability/Managing Complexity
The interconnectedness of today�s world brings with it
unprecedented complexity. Interaction in such an
environment requires individuals able to plan, design
and manage in new ways. Such individuals can handle
contingencies, anticipate changes, and understand
interdependencies among systems.

� Curiosity, Creativity and Risk-Taking
Researchers now understand how the very structure of
the brain can be changed through intellectual pursuits-
�there is a corresponding relationship between the
amount of experience in a complex environment and the
amount of structural change in the brain-in other words,
learning organizes and reorganizes the brain.� Curiosity
fuels lifelong learning just as it contributes to quality of
life and to the intellectual capital of a country. Equally
important is risk taking-without which there would be
few quantum leaps in discoveries, inventions, and
learning.

� Higher Order Thinking and Sound Reasoning
For decades, research has called for higher order
thinking and sound reasoning in P-12 curricula. Thinking
skills have been defined as the ability to think creatively,
make decisions, solve problems, and see things in the
mind�s eye, whereas sound reasoning enables students to
plan, design, execute, and evaluate solutions. These
processes are often carried out more effectively using
technology.

Interactive Communication-Social and Personal Skills
� Teaming and Collaboration
The rapid pace of today�s society has caused a down-
ward shift in the level of decision-making. At the same
time, the complexity of the 21st century requires a high
degree of specialization by decision-makers-hence the
need for the teaming of specialists to accomplish tasks
efficiently, effectively and in a timely manner. Informa-
tion technology such as email, faxes, voice mail, audio
and videoconferencing, chat rooms, shared documents,
and virtual workspaces, can facilitate and enhance
collaboration.
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By Julie Rossi and Margaret Dials

First of all, we wouldn�t have been able to create the Hanby Book Buddies project without the help of Nick Viani at the
ESD. [Aw, shucks�Ed.] He took our ideas and created an online bulletin board for students to discuss books. We wanted to
offer our TAG students a unique experience that combined the reading of challenging books with the technology of online
writing. Students were already engaged in journal-writing about books in their reading workshops, and we wanted to take
that one step further.

First we held a meeting with all of our
TAG students (about twenty 7th and 8th
graders) and presented book talks on the
books nominated for the 2002 Young
Reader�s Choice Awards. We had two
copies of each book for students to
check out and asked them to give us a
secret code and their first three choices
of books they would like to read. We
then assigned books and passed them
out in envelopes so nobody would know
what anyone else was reading.

They were required to answer one
question a week from a list of questions
we posted on the web site from the
beginning, middle, or end of their books. They posted their answers on the beginning, middle, or ending discussion boards
and included the comprehension question in their answer. Each student had a buddy who was reading the same book.
Students were also required to respond to their buddies� answers at least once a week. The idea was to create a dialogue
between the two students about the book they were both reading.

Students were enthusiastic about their books, and many were
enthusiastic about writing on the web site. We were surprised
by the overall response to the program. Only a few students
(about four) continued to use the web site after finishing their
first book, although they actively kept checking out the
books. Many admitted that they enjoyed reading what others
had said, but they just didn�t get around to responding
themselves. We had thought that the hidden identity of book
buddies would be fun, but the kids were more interested in
the books than in who was reading with them.

We have a special section in the library for the Hanby Book
Buddy Books. Any student can check them out with the
understanding that they will respond online. We are going

to encourage students who have moved on to reading other books to return to discussion boards of books they have already
read and respond or post questions for students who are currently reading that book. Our goal is to create a continuous
discussion of the books.

Visit the Hanby Book Buddy Project
Browse to www.jacksonesd.k12.or.us:591/it/cpost/sows/hbb/index.html.Also check out www.literaturecircles.com and fac-
staff.seattleu.edu/kschlnoe/litcircles/use.html for ideas. You�re invited to design your own online discussion group. Contact
Nick Viani at nick_viani@jacksonesd.k12.or.us and he�ll walk you through it.

Hanby Book Buddies is an adaptation of the Southern Oregon Write Site

Literature discussion circles
debut online at Hanby MS

�I can't belive the end!!! Is the father going to
kill him or not? But if he was at least he won't
have to suffer. Just imagine what it would be
like, to not be able to talk to anybody or have
any way of comunicating with others. I would
go crazy! The author makes it seem so real,
and that nothing good can happen. I wonder
if there are people like this....�

�a recent comment

�Book Buddies is a good way to get people thinking about
what they read....other people respond to what you write

about and they have good questions that cause you to look
at the story from a different view.� �Tiffani

�I...enjoy being able to get on the Internet to �chat� with the
person�it�s almost like checking e-mail. I think that our

school should expand the program to everyone, so that they
can all do it instead of writing in journals.� �Marissa

�Doing this project is fun! I like to talk to someone else about
my book and get his or her opinions.� �Kelsey
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Jackson ESD�s Professional-Technical Education and
Instructional Technology Departments are debutingWeather-
Net this month, a consortium of 15 schools and a supporting
web site. Each school has a RainWise weather station, of
these 15 sites seven are online. At the online sites weather
data is downloaded every 15 minutes to the ESD, where it is
available on the WeatherNet website. But, the WeatherNet
website and project is much more than just a source for
current local weather conditions.

Included are a middle and high school science curriculum
and powerful resources, providing topographic and precipi-
tation maps, topographic cross sections of our three-county
service area, annotated weather links and a resource where
for obtaining regional weather data for the period 1961 to
1990.

WeatherNet Curriculum
The curriculum is divided into four lessons which address
several Oregon State Benchmarks.
� Lesson 1 students track storms using the data supplied
byWeatherNet�s online weather stations. In this lesson
they document the rain shadow effect, that is, changes in
precipitation as storms move west to eat across the
Illinois Valley, the Rogue River Valley, and into the
Klamath Basin.

� Lesson 2 students explore what causes a rain shadow�
the adiabatic rate�in a mini-webquest, then do calcula-
tions on a simulation to apply what they have learned in
their research.

� Lesson 3, Let it Snow, Let it Snow asks the question:
Where does it snow more, Portland or Medford? To
answer this question students do three mini-lessons
based on webquests. Students first study different types
of precipitation and how they are formed, and then they
analyze snowfall data for Portland and Medford. The
final mini-lesson builds on the first two and involves
comparing and contrasting differences in the mecha-
nisms producing Medford snowfall and Portland
snowfall (the Gorge Effect). The conclusion to Let it
Snow, Let it Snow asks students to compare snowfall and
climate data over a period of 40 years in making an
assessment about whether or not there has been a change
in the climate of Western Oregon. (Note: A complete set
of rubrics is included for all parts of Lesson 3.)

� In Lesson 4 students expand their view fromWestern
Oregon to the world as they explore the question of
Global Warming.

WeatherNet Resources
WeatherNet provides regional curriculum resources on

several levels. The incorporated lessons focus inquiry
regionally, first Southwestern Oregon, thenWestern Oregon,
and students compare and contrast weather with climate.
Each lesson is a stand-alone lesson that can be used as part
of weather unit for a classroom or as individual lessons for a
specific student. Since the data provided by WeatherNet is
real-time dynamic data, it can be incorporated into science
inquiry lessons independent of the lessons provided.

Meet (or exceed) Oregon Benchmarks
As for Oregon Benchmarks the incorporated lessons address
several 5th, 8th, and 10th grade benchmarks including using
conceptual models to make predictions, describing weather
in measurable quantities, interpreting data over a period of
time, comparing weather in the student�s area with weather
in other areas and climates, the difference between weather
and climate, defining factors that cause or affect weather
patterns, identifying examples of condensation in the
student�s environment, analyzing the effects of human
activity on the amount of carbon dioxide in the atmosphere
and global climate, and describing the effect of gases on the
amount of solar energy captured by the Earth system.

It is our hope that WeatherNet will provide a valuable
resource for students and teachers in both lessons and raw
data. The website for WeatherNet is www.jacksonesd.k12.
or.us/weather. The site is undergoing constant revision to
meet your instructional needs, and I would appreciate your
comments, suggestions and corrections. Contact me at
thomas_glover@jacksonesd.k12.or.us. Enjoy the weather!

More than just a source for local weather conditions

WeatherNet debuts
By Tom Glover

This is sample of the weather data available every 15
minutes on WeatherNet for the seven online WeatherNet
sites: Illinois Valley High School, North Valley High
School, Rogue River High School, Medford ESD,
Phoenix High School, Ashland Middle School Science
Institute and Mazama High School.
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By Larry Francis

Explanation must be understood as a particular form of insight.
�Michael Polanyi, �Logic and Psychology�

Anyone trying to learn a language knows it�s so hard and so important to get speech to stand still so you
can remember meaningful chunks. In olden times, music and poetry helped people remember stories, but
the big breakthrough for capturing and recalling language was literacy, theWriting/Reading technology.
Before that, language meant oral language. Nowadays, of course, a big part of schooling is the task of
installing, coordinating, fine-tuning, and exercising that literacy technology in our students� eyes, ears,
mouths, hearts, and minds, to name a few organs.

Now we�ve got multiple literacies�and a much newer technology for getting speech to hold still and be
easily and universally accessible: digital audio recording and playback. Digital audio captures idiosyn-
crasy, voice, rhythm, and mood way better than text does, but it lacks text�s flexible generalizability. With
software that comes built-in with Windows and is downloadable freeware for Macs, plus cheap mics that
generally come built-in with Macs and cost only about $6 for PCs, there�s no reason why we shouldn�t take
advantage of both technologies in our teaching�the old text one and the new digital one and use them to
enhance each other.

Capturing voices is easy on both Macs or Windows, but you just gotta have:
(1) a microphone
(2) software for capturing audio
(3) a sound card to hear audio (if its not installed on your PC; Macs always have �em)

Here at Jackson ESD, the microphones we use on our Macs came built-in on the laptops and were included
in the same box as the towers. On the Windows side, we had to buy them, but they were only about $6
each. (Contact Gary Wagoner in Repair (541.776.8570 or 800.636.7454). The software, SoundRecorder,
is a free download on the Mac side and built-in to the Windows operating system.

To download SoundRecorder, go to www.download.com and search for SoundRecorder (no space) or go to
www.mp3mac.co.uk/Downloads/SoundRecorder.sit. Then just double-click on the SoundRecorder icon to open it.
You have to configure it. There�s a nice how-to for SoundRecorder at www.emsb.qc.ca/recit/aamemo/sr_mac.pdf .
The key things to remember if things don�t work right are

1. If the recording isn�t happening, check the source to make sure it�s looking to the correct mic for input (usually built-in or
external), and

2. If the sound�s not loud enough,
slide the input level to the right
a bit. I like it about halfway
between zero and one.

On the Windows side, there�s
nothing to download since it�s
built (buried, actually) into the
Windows OS. To access it, go to
Start > Programs > Accessories >
Entertainment > SoundRecorder.
You may need to configure the
volume properties for the
microphone and make sure the

mic is not muted. The normal Volume Control properties are for Playback, not Recording. To get to Recording Control, you
need to go Volume Control > Options > Properties > select Adjust Volume for Recording (not Playback). Then when you get

Giving students a voice

Sound practices II
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there, select Microphone Balance, not CD Balance.

Inserting Sounds
Once you�ve captured your sound, you can put sounds in lots of
documents. Here is how to do it in a few major applications for
Mac or Windows:

AppleWorks or ClarisWorks�you�ll be inserting a QuickTime
movie (File > Insert)
Word�you�re inserting a Movie (Insert > Movie)

Kidspiration�lets you record your own sound from within the application (Sound > Record) but you can�t insert a sound
captured somewhere else.
PowerPoint�gives you a lot of options: you can insert a sound you�ve captured (Insert > Movies and Sounds > Sound from
File) or pick from a gallery (Insert > Movies and Sounds > Sound from Gallery) or record your own (Insert > Movies and
Sounds > Record Sound).
KidPix� like Kidspiration, lets you record but not import. Go to Goodies > Record a Sound. There is a Goodies > Pick a
Movie, but I couldn�t get it to work with a short QuickTime audio or a short .wav audio.
Attach your sound file to an email�Sound files don�t take up much space, so you can attach �em to emails without
choking somebody�s mail server or triggering a loooooong download on their dialup connection. As for format, .wav is a
good choice, since Windows is happy with .wav and QuickTime can read .wav files just fine. Most Macs have QuickTime.
You can download it for Mac or Windows from www.apple.com .
HTML�a quick page I slapped together with embedded sound is at www.jacksonesd.k12.or.us/it/staff/lf/pollitos.

But what sound to insert? It depends, of course, on so many things�like the presenter, her or his purpose, passion, and
audience, to name a few. If you�re thinking of a PowerPoint presentation or AppleWorks slideshow, don�t miss Jamie
McKenzie�s great article, �Scoring Power Points,� available online at www.fno.org/sept00/powerpoints.html . Here are a few
more humble ideas:

1. Digital sub tub: make a digital folder for your substitute with your classroom procedures and a short
recorded message from you calculated to frighten your impressionable students into impeccable behavior.

2. Story starters: use a short sound clip to get students in the mood to write about a dark and stormy night, their
most unfavorite food, their happiest surprise, or whatever

3. How-to documents: break down a task (math, language arts, classroom or school procedures�any se-
quenced activity is fair game here) into steps, write down the steps and have a student sound clip explain
each one.

4. Songs: make a singing songsheet where you have a sound clip right next to the lyrics.
5. Grab a sound file off the web and insert in a document to be read or transcribed or responded to. I went
www.dailywav.com and snagged Margaret Hamilton�s �I�ll get you my pretty and your little dog, too!�

Meaning has to be personal or it�s not even there, and it has to be universal or no one else will care. (Let�s assume the
universality of most of what we�re trying to teach and focus on the personal part of meaning.) We know from Bloom�s
Taxonomy�and common sense�that a curricular bit has found a home in students� heads if the students can put it into their
own words. This means to me that any student presentation�and probably any teacher presentation�needs a sound track
that reads, interprets, explains, elaborates, something, that personalizes the slideshow, essay, web page, or whatever.

Text-to-Speech & Speech-to-Text
Besides amplifying, elaborating, and personalizing the tone and meaning of a chunk of text, digital audio is a great tool for
students working to make the connection between oral and written language. Reading could be crudely defined as getting
from text to speech. Writing could be likewise defined as getting from speech to text. As I explained last time in �Hearing
Voices,� students struggling with Reading (big R) can start with the text, practice reading it with robot tutors, then trium-

Left: Windows users have a built-in program for recording
voices called SoundRecorder�and you have to dig to find it.
To access it, go to Start > Programs > Accessories > Enter-
tainment > SoundRecorder.

See Sound on next page
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phantly record their own performance. They could, however,
go the other way around, skipping the robots and just telling
their story, capturing it with SoundRecorder. Once they�ve
gotten their story to hold still, students can review it for
fluency, flair, coherence, or whatever. Then it could be re-
recorded and re-reviewed until it met the students� standards
(or yours). When students have their stories sounding just
right, the oral output��reading��is taken care of, freeing
them to work on encoding talk into print�that is, writing.
Classmates, friendly adults, or cross-age tutors can help, of
course, with the transcription. Robots, once again, provide a
conventional check: by comparing the robot�s text-to-speech
reading of story with the student�s own digitally recorded
telling, students can debug their writing chops and tune up
their conventions.

Full Circle�Hammering Home
The whole reading/writing game is about making meaning
and communicating it conventionally. On the receiving end,
the listener has to remake something like the originally
intended meaning, or there really wasn�t any communication
at all. But you knew all that. Multiple literacies, of course,
give us the chance to make our meanings more and merrier.
But you knew that too. My hope is that by now we�ve come
full circle with Sound Practices I and II, since last time was
about getting robot voices out of your computer and this
time we took a look at getting student voices in.

For Further On or In
If you�re interested in Polanyi�s philosophy, see Michael
Polanyi�s Personal Knowledge, or maybe better, The Tacit
Dimension. Online, Stefania Ruzsits Jha has a nice bit in
Chapter 5 of her PhD thesis, �Michael Polanyi�s Integrative
Philosophy,� www.kfki.hu/chemonet/polanyi/9602/mp1.html
or you can go to the Philosophy Research base,
www.erraticimpact.com/~20thcentury/html/
polanyi_michael.htm

For a couple of online articles on making meaning, see John
Seely Brown, �Stolen Knowledge� www.parc.xerox.com/
ops/members/brown/papers/stolenknow.html and Ellen
Langer, �On the Power of Mindful Learning�
www.omnimag.com/archives/chats/bm120397.html.

For a couple of articles on �power pointlessness,� besides
Jamie McKenzie�s classic �Scoring Power Points
www.fno.org/sept00/powerpoints.html, see Joyce Kasman,
�PowerPoint effective, but often misused�
joycevalenza.com/powerptart.html.

For other resources, like how to downsize bulky sound files
or bulky graphics files so they don�t take too long for
people with dial-up connections to load and for the most
current version of the forgoing, see
www.jacksonesd.k12.or.us /it/staff/lf/soundpractices.

Sound (continued) Summer inservice
opportunities
The ESD�s Curriculum Department is offering a variety of
summer workshops. Please share the following information
with teachers and educational assistants at your school.

Descriptions and registration are available on the Jackson
ESD web site (www.jacksonesd.k12.or.us). Click on Staff
Development Opportunities.

Early Reading and Federal Legislation�Ric Latour
8/19, 8:30-3:30, McLoughlin MS (Medford), Gr K-6, Free

Differentiation by Design�Julie York
8/19-20, 8:30-3:30, McLoughlin MS (Medford), Gr K-12, Free

Super Seven Reading Workshop�MaryBeth Munroe
8/22, 8:30-3:30, McLoughlin MS (Medford), Gr 2-8, Free

Storytelling, StoryFest and Speaking Benchmarks�Barbara Griffin
8/23, 8:30-11:30, McLoughlin MS (Medford), Gr K-8, Free

Teaching with Two-Way; A Videoconferencing Adventure�Sheryl Lipski
8/20-21, 8:30-4:00, Phoenix HS, Free

MonArt Institute: How to Use Drawing in an Integrated Curriculum
Carol Kolnes�6/25-26, 8:30-3:30, Phoenix HS, Gr K-6, $100

Make and Take It! Writing and Speaking Toward the Benchmarks
Michael Lenhart�7/16-18, 8:30-4:00, Grants Pass HS, Gr 1-6, $225

Crater Lake National Park as an Outdoor Classroom�John Salinas
7/31-8/2, Crater Lake National Park, Gr 1-6, $195

Shared Inquiry: Junior Great Books
8/7-8, 8:30-3:30, Jackson ESD, Gr 2-10, $149

Every Day Counts Calendar Math�Jan Gillespie
8/12-13, 8:30-3:30, Parkside Elementary (Grants Pass), Gr K-5, $150

Activities Integrating Math & Science (AIMS)�Cris Richardson
8/12-16, 8:00-3:00, Highland Elementary (Grants Pass), Gr K-6, $185

Handbuilding with Clay: Projects for the Classroom�Susan Rodin
8/12, 8:30-3:30, Phoenix High School, Gr K-8, $30
8/13, 8:30-3:30, Ponderosa Jr. High (Klamath Falls), Gr K-8, $30

Classroom Management with Standards-Based Demands�Sheri Smith
8/13, 8:30-3:30, Howard Elementary (Medford), Gr K-6, $35

Science Inquiry Now!�Sean Nolan and Justin Adams
8/14-16, 8:30-3:30, Science Center (Ashland), Gr K-6, $225

Language Arts Writing Collaborative�Sheri Smith
8/15, 8:30-3:30, Howard Elementary (Medford), Gr K-6, $35

Advanced MonArt: Using Drawing in an Integrated Curriculum
Carol Kolnes�8/20-21, 8:30-3:30, Grants Pass HS, Gr K-6, $110

Sea Camp for Educators�Sean Nolan and Allyson McCauley
8/20 (8 AM) - 8/23 (2 PM), OIMB Charleston, Oregon, Gr 4-12, $325

University credit will be available. Contact Pam Marshall at
776.6771 or pam_marshall@jacksonesd.k12.or.us for
information on classes, college credit, and registration.
PDUs (Professional Development Units) will be provided at
the completion of each course in which you participate.
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internet. Check out websites like PalmPilot�s education site
(www.palm.com/education) or The Center for highly
Interactive Computing in Education (HiCe site at hi-
ce.eecs.umich.edu/index.html ) So would you like to be part
of this world?

PDAs in the Classroom grant
To introduce PDAs to teachers in our region we are starting
a two-year project with eight teachers. Each teacher will
receive a Palm Pilot of their own on permanent loan. They
will also have access to a lab of 25 PDAs for one month
during the school year for two years. In return, teachers will
learn to use the PDA for their own administrative use.
They will also create written lessons they can share with
their colleagues.

Write a short description of why you should receive the
PDA. Include the grade level you teach, your school, just
how you think PDAs could help you and your students (that
is: What would you like to do with your PDAs), and a
comment about whether or not you presently incorporate
technology in your curriculum. Send the request to Thomas
Glover by email at thomas_glover@jacksonesd.k12.or.us by
June 1. We will notify recipients before the end of the school
year. We will meet either duringAugust or early September.

You see them cropping up everywhere these days, the PDA,
or Personal Digital Assistant. These are those little, fit-in-
the-palm-of-your-hand personal computers. It is interesting
to note that these handheld computers have nearly the
computing power of the original desktop Macintosh. People
use them for keeping their calendars, as calculators, for
taking notes, as databases or spreadsheets, plus specialized
applications just like that computer that sits on your desk.

Here in Instructional
Technology we are
exploring the idea of
using PDAs in the
classroom for curricu-
lar use. Yes, I know
one of the first
reactions is: but, they
have such small
screens, can they really

be used for serious classroom application? The answer is
YES. Remember that to those of us from a certain generation
who have always used large screens, the PDA �human
interface� may seem small, but to a generation who have
grown up with �GameBoys� and cell phones the PDA
interface is not small at all. Plus, PDAs can be �HotSynced�
(that is, hot wired) to your desktop computer for transferring
files between your PDA and your desktop computer.

Math applications
I have seen some very exciting classroom uses for PDAs.
ImagiWorks makes great graphing software for teaching and
exploring math. But, why PDAs? Why not regular comput-
ers to teach math? The answer lies in the low cost of PDAs,
their portability and their �individuality.� By this I mean that
they are used by each student individually. Imagine a
classroom where every student has his or her own computer,
a hand-held computer, a classroom with computers but no
wires.

Science applications
In addition to math, they can be used with probeware.
Remember, the ESD has a set of Vernier temperature probes
for checkout. Using a portable foldout keyboard, students
can use them for writing projects, taking notes, etc. The
possibilities are limited by one�s imagination only. I recently
downloaded an astronomy program off the internet for my
PDA that is more powerful than the astronomy software I
used in the classroom just four years ago�and it is portable.
There is a great deal of free software for PDAs right off the

PDA: Personal Digital Assistant

The World in the Palm
of Your Hand
By Tom Glover

Any concerns you may have about using the PDA for text
entry are alleviated with the inexpensive, portable,
collapsible keyboard accessory. Plug it into the PDA and
you�ve got a fully-functioning word processor that�s
completely interactive with your desktop computer and
still fits into your pocket. And you thought the
functionability of AlphaSmarts was cool!
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Tips & Tricks

Recording sounds
in Kidspiration
In Kidspiration, you and your students can record
sounds or words and attach them to symbols to
expand and reinforce learning. The Record com-
mand is only available when Record Sounds is
turned on in Application Options (click Application
Options on the Teacher menu to explore this and
other options). Your computer needs a microphone
(about $6 from the ESD).

To record sounds or words and attach them to a
symbol or idea:

1 Select the symbol or idea.
2 On the Sound menu, click Record.
3 In the recording controls box, click Record to
begin recording.

4 Generate the sound that you want to record.
5 When you finish recording, click Save to save
the recording and attach it to the selected
symbol or idea. (The maximum length of a
recorded sound is fifteen seconds. You can
click Stop at any time to end recording.)

In Picture View, a speaker icon appears in the
upper right corner of a symbol when a recorded

sound is attached. In
Writing View, it appears
to the left of an idea.

Try adding sounds to
your Kidspiration
projects today! Teachers
can create symbols with
instructions on how to
use the activity they�ve
created, using the
Record command to
provide spoken instruc-
tions for their students.
Students simply click on

the microphone icon to hear your instructions
before they complete the activity.

Note: To remove the recorded sound from a symbol
or idea, select the symbol and choose Erase from
the Sound menu.

Spring is in the air and Southern Oregon Online students are
racing toward the electronic finish line with just a little less
than one month before final grades are due. More than 100
high school students from Southern Oregon are taking over
150 credit courses from Southern Oregon Online School in
math, science, social studies and English. A new course
added this year is Health/Wellness. It has proven to be very
popular with almost 30 students completing credit.

SOOS continues to be a flexible alternative for high school
students who are juggling work schedules, class schedules,
sports, and a variety of life situations that make getting
graduation course requirements taken care of nearly impos-
sible in a conventional school day. SOOS students may
work at school or from home or the public library or
anywhere they have web access�anytime of the week.

SOOS not only provides flexibility to students but to schools
as well. In Oregon�s current budget tightening, schools can
use online courses to expand their offerings and meet the
needs of their student populations. Instead of overloading a
face-to-face class, additional sections can be filled with
online students. Courses that don�t have enough enrollments
to provide a full-time teacher could still be made available
through SOOS. The current SOOS course cost to schools is
less than the cost of a face-to-face course.

Web-based teaching and learning is expanding around the
state of Oregon. There are currently web schools sponsored
by Salem-Keizer School District, Linn-Benton ESD,
Northwest ESD, and Corvallis SD in addition to SOOS. The
Oregon Online Leaders, made up of representatives from
existing online schools, the Oregon Department of Educa-
tion, OPEN, and other interested members have met to help
build the capacity for online education around the state. In
the planning stage is a web site for students listing all
available online courses around Oregon and links to online
curriculum available to all teachers.

In late June, Jackson ESD will be hosting a weeklong
summer institute for teachers from around the state. Partici-
pants will explore effective teaching strategies for distance
learning, learn to use powerful online tools and resources,
and create online curriculum. (See the article �Instructional
Technology Summer Inservice� elsewhere in this issue.)

SOOS thrives
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In the primary classroom we spend a lot of instruction time
guiding children through the writing process. Beginning with
brainstorming and moving to organizing ideas and words
into sentences and then paragraphs, teachers have made
great use of butcher paper and markers to
help kids see the transformation of ideas
into written paragraphs.

Kidspiration is idea-mapping software created for primary
students that allows them to brainstorm electronically. Ideas
can be displayed graphically, moved around on a page,
sorted, and organized.

Students can then move their ideas to electronic paper and
add words and punctuation to make them sentences. The
lesson plan below outlines a two-day beginning writing
activity for a primary classroom. Take a look.

Lesson Plan for Kidspiration

Day One: Prewriting (Creating your animal web)
Brainstorm with students in Inspiration the names of animals
they have been studying. Save Inspiration brainstorm for
student reference.

Directions:
1. �We�ll be doing some writing about these animals using
a program called Kidspiration.�

2. Show the Kidspiration screen and choose an animal as a
group to use as a sample.

3. Go through the directions on the handout with the whole

class using one of the animals we�ve identified. Save for
use on day 2

4. �During group time, you will have the opportunity to
create your own animal web using the name of an animal
from our class web. Think about which animal you want
to use for your web. You will need to think about 4
things to describe your animal so that you can add
details to your web, just like we did as a class.�

Work with students in small groups at the computers to
create and save their animal webs.

Day Two: From web to writing
Open up the Kidspiration web we created on day one.
Remind students how we selected an animal, then think of
four things to describe that animal.

Directions:
1. �Today we will turn our animal web into a paragraph
about our animal.�

2. Use the sample web to show how we can look at our web
in another way in the writing view.

3. Have students turn ideas into sentences.
4. Record on the writing view
5. Show how you can move the sentences around.
6. Click back to picture view to show that whatever you
change in the writing view shows up in the picture view.

7. Show the print and export option.
8. �During group time, you will have time at the computer
to write with your own animal web using the web you
started on Monday. When you have finished turning your
ideas into sentences, be sure to save your work and print
a copy to show your teacher.�

Work with students in small groups at the computers to
create and save their animal writing.

Learn more about Kidspiration and Inspiration at
www.inspiration.com. Note: Kidspiration costs $69 from
www.inspiration.com (800.877.4292). 30-day demo CDs are
available from Tina here at the ESD. Call and she�ll send
one to you via the ESD courier or download a free trial
version from Inspiration�s web site.

Kidspiration activity books are $19.95 each. An �Exploring
Kidspiration� interactive CD is $24.95. Contact their sales
department for volume pricing and academic discounts.
Katie Storment (ext. 129) is their Oregon Schools rep.
Contact Tina at tina_mondale@jacksonesd.k12.or.us.

The primary classroom

The writing process with
Kidspiration
By Tina Mondale
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